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This set of notes includes Hints and Tips and sample Notebook files are to be found on Fife Education’s Learning and Teaching website.

Q. How can I reduce the glare on the screen?


Try these two solutions.

1. Chick your data projector settings and reduce the bulb intensity to the lowest setting.  You will need to click on the Date Projector’s menu button or use its remote control menu button.

2. In Notebook or another application such as PowerPoint change the background colour to a darker colour and check if the text colour has to change to keep the text legible.
New version 9.5 (summer 2006 – the version issued to Fife schools in session 2006/07)

Q.
What is new in version 9.5 and why should I upgrade?

1. There are a number of reasons why you should upgrade to 9.5. This upgrade is free to SmartBoard users and offers a significant improvement in the content, the added functionality of the tools such as infinite cloner and the diversity of the gallery, including a significant number of interactive (Flash) files.

Q. What operating system does it require on my computer?

1. In practice this version requires Windows 2000 or XP to function correctly.

Upgrade to version 9.7 released by SMART in June 2007 – this will be issued to Fife schools in the autumn term 2007

Although this version can be downloaded just now I will create CD versions for distribution to schools once I have completed tests over the summer recess.

Please refer to Version 9.7 changes at the end of this document for more information.

Notebook Questions

Q.
How can I use the same page more than once and modify the content?


This is especially useful for work created for different groups in a class.


1.
Create the most complex level first and check it is in the order you want.


2.
Click on Page Sorter, then the ↓ pull-down menu arrow and choose ‘clone page’.


3.
Modify the cloned page to suit and repeat step 2 if needed.

Q.
I wish to make multiple copies of an object (image from the gallery or text or shape placed on the work area of the page) but I don’t like going back to the gallery all the time as it makes it slower for my class and me.




1.
Select your object and place it on the page.


2.
Click on the object and use the ↓ pull-down menu arrow.


3.
Click on Infinite Cloner.


4.
Now drag as many copies from the original as you need.


5.
Remember to switch off the Infinite Cloner on the original object once you are finished.

6. You might want to keep the Infinite Cloner on for pupil use. Have a look at pages 6 and 7 of the Notebook Software Activity Guide for a maths and a language activity.

Q.
How can I create a Notebook file that lets me move to any page I choose rather than working through the pages sequentially?

1. Use the Link properties on every object (on ↓ pull-down menu arrow on selected object) have been extended in Version 9.5 to include this feature where previous versions were only able to hyperlink to a website address.

You can now create a page and link it to other pages in the same notebook file, for example to create a contents page.

Q.
Can I link to a web site?

1. Yes, select an object, click on ↓ pull-down menu arrow and click on Link.

2. It helps to know the web address (URL) for this task beforehand, as it has to be added at this point.

3. Choose corner or whole image as the link – the choice is yours but be consistent if you are doing this with other pages or files as your class will come to recognize this feature in your files.

Q.
How can I make the text legible from the back of my room yet print in normal size?

1. The normal print size is 12 point.  So, if you are viewing a word-processed file, go the View menu and select a Zoom with magnification perhaps to 150% or 200%.

2. If you have followed step 1 and increased the Zoom View but the text was off the screen and you had to use the horizontal scroll bar then within Microsoft Word go to the View menu and change to Web Layout which adjusts the width and removes the horizontal scroll.

CAUTION


If you wish to use the Smart pens to “insert” text the View has to be switched back to Print Layout.  An error message will remind you to make the change. 

Hopefully this problem will be solved in future releases.

Q. How can I preset the text format and point size so my class don’t have to repeat this activity?

1. Within Notebook choose the down arrow beside the Text button (represented by the letter A), go to the bottom of the list and select Customise Text. Set the font, the point size, colour and style then click OK and this will become the default setting for subsequent work until this process is repeated.

Please refer to the Notebook Software Activity Guide (downloadable from the Smart Tech website) publication for more information.

Q.
I would like to write on the SmartBoard in a broader point size so the children can track and write the text more easily

1. Click on the Smart icon on the taskbar and choose Control Panel.

2. Select the Pen and Buttons option, choose the coloured pen you wish to modify then select it width and line ending. 

3. Click OK to save and close the Control Panel. Remember that the selected pen will retain these settings until steps 2 and 3 are repeated to reset the pen.

Q
What point size is easiest for writing on the Board?

1. This is a matter of personal preference but younger children seem to prefer a wider pen width than the default setting. Just experiment until you achieve the optimum pen width for your class. When using the keyboard try point size 24 and either go larger or smaller to suit your needs.

Q.
I want my pupils to match objects using an arrow headed line but they find this quite difficult to do freehand.

1. Reset one of the pens to be a broader point size and with an arrow as its End.

2. Click on the Smart icon on the taskbar and choose Control Panel.

3. Select the Pen and Buttons option; choose the coloured pen you wish to modify then select its width and line ending. 

4. Click OK to save and close the Control Panel. Remember that the selected pen will retain these settings until steps 2 and 3 are repeated to reset the pen.

Q.
I have opened a Notebook files but I only want to keep a few pages.

1. Go to the Page Sorter to view the thumbnails.

2. Click on a page you don’t want to keep and then click on the pull down arrow and choose Delete Page.

3. Repeat step 2 as often as you wish.

4. Now save this reduced version as a new file by following the File – Save As route and place the file either in My Notebook Contents in the computer’s My Documents folder or to a location on the school server, perhaps your own personal or class space.

Q.
I would like to include images from other sources in my Notebook file?

1. If the image is already held as a file, go to Insert Image and navigate to where it is stored.

2. If you have seen an image on a website and have checked the copyright then right click on the image and copy the picture.  Now click on the Notebook page and choose Edit – Paste or use the keyboard shortcut CTRL-V.

3. If you only want a part of an image and have checked the copyright then switch on the Floating Tools and choose the camera tool then drag from top left to bottom right across the image.  Once you release your finger the captured image will be inserted directly into the active notebook page or, if necessary, a new Notebook file will be opened automatically.

Note: The Floating Tools are only active when the computer is connected to a SmartBoard.

File types

Q.
What are the different types of files in the gallery?



There can be

1. a standard image which can be moved anywhere on the page and 

2. an interactive file run as a self contained application.  (Flash - red letter F) or

3. a  background (noted by its folded top right corner).

4. Video clips represented by a film strip icon

5. A spiral binder with a specific filename represents notebook files of more than one page. For example look in Gallery – Mathematics – Counting – scroll down to “What is Percentage?” and drag onto to the page (work area). Smart calls these Lesson Activities and these can be located using the Search feature within the Gallery.


Note: Once the selection appears on the page (work area) it is referred to as an object with the exception of a background.

Q.
When I insert a Flash file it just shows a jigsaw piece and I cannot run the file?

This is an indication that your computer does not have the Flash application installed.  The Flash reader is a public domain application that can be downloaded free of charge.  Fife teachers should download the latest Flash file from section 5 (ICT – downloads) of the Fife intranet (FISH).


Other sources for SmartBoard related resources

Q.
I would like to buy a printed guide to the SmartBoard.  Which one do you recommend?

1. The Flip Guide produced by the University of Christ Church, Canterbury is an excellent purchase.

Q.
Where can I find Help Sheets?

1. Notebook’s own online Help feature is worth exploring. Just select the Help icon from the top right of the window when Notebook is active.

Q.
Where can I find step-by-step tutorials?  

1. A few introductory tutorials are held on the Fife SmartBoard CD ROM. Look in the Training Notes – Hands On Practice folder.

2. Very good, short online tutorials are to be found on Smart’s own website at 



Please look at the 2-minute clips or the Hands On tutorials.


A Notebook Software Activity Guide is available from Smart.  It contains useful instructions on a few of the key features of Notebook version 9.5 some of which are mentioned elsewhere in this FAQ.

Importing PowerPoint into Smart Notebook

Prior to version 9.5 Smart users could interact with a PowerPoint file using the Digital Ink feature (4 pens), that is if Smart software was installed on the computer running a PowerPoint file – this is referred to as a Smart Aware feature and results in a new toolbar added to PowerPoint’s menu lines (or to Word, Excel and Publisher).

However, greater interactive opportunities are present in version 9.5 as it is possible to import a PowerPoint into Notebook and it will be replicated on a PP slide per Notebook page basis. All the content will be active such as text boxes and images.

This feature could save teachers a great deal of time as they might be new to SmartBoards but are likely to have accumulated a large collection of PowerPoint files over the years.

Method:


It is simple just

1. Locate the PowerPoint file 

2. Open Smart Notebook

3. Go to the File Menu and choose Import – then select your PowerPoint file making sure the file type is set at All PowerPoint files

4. You will have to wait a short time for the PowerPoint file to be converted into Notebook

You can now work on making your old file interactive and setting tasks for your class.

Exporting Notebook files in different formats

Version 9.5 offers 4 export options which are worth investigating.

Think of the occasions when you might want colleagues to view your Notebook files but they don’t have Smart Notebook on their computers. So just choose the File – Export path and they could view your work as one of four choices:

1. A Web Page – the Notebook file is converted to a web page and a folder created automatically to hold related images and other code. Even if there is more than one page the resultant HTML page has page navigation added.

Be careful as the web page doesn’t transfer any backgrounds.

2. Image files – you will be asked to locate the folder you wish to store the files and you can add one at this point and choose the image file type from .png or .jpeg or .gif or .bmp and the screen resolution. Just try a few permutations and view the results.

Note: Each Notebook page will be saved automatically as a separate image file.

3. A .pdf file (An Adobe Acrobat file). Just try it out and decide if this suits your needs.

4. As a PowerPoint file. The saved file recreates each Notebook page as a self-contained PowerPoint slide, including any background images.

Creating new backgrounds and saving them for future recall

Place your image on a page then lock this object in place. 

Go to File - Save as a Gallery Item - enter a filename and save the file wherever you fancy. 

Either on the same visit or later, click on the Gallery tab then My Content and on the pull down menu choose "Add to My Content". 

Locate the file you just saved and it will be added as a background with the distinctive top right folded corner. 

This could be useful for watermark-type backgrounds.
